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Creating Run Charts (Time Series Plots, Line Charts) 
Excel 2010 Tutorial 

 
 

Excel file for use with this tutorial File Location 
GraphTutorData.xlsx http://faculty.ung.edu/kmelton/Data/GraphTutorData.xlsx 
 
Introduction: 
 
Purpose:  Run Charts provide a visual way to see how quantitative values compare across time.  
Although some people use Bar Charts for this situation, Run Charts provide the same 
information with less chartjunk (redundant ink on the page).  Run Charts have a horizontal and 
vertical axis where time is shown on the horizontal axis and the vertical axis represents the value 
of the variable of interest.  The Run Chart plots dots for the observed value at each point in time 
and connects these dots with line segments.  Often, Run Charts include a horizontal line on the 
chart that shows the average value. 
 
Data for this example:  We will use the same data and address three questions.  These data are on 
the first two sheets in the GraphTutorData file (accessed at the lower left of the spreadsheet).     
 

 
 
The data on the Enrollment sheet relates to enrollment in the BBA program from Fall 2001 
through 2012.  The data on the Majors sheet shows the distribution of students across majors for 
Springs of 2007 through 2013.   
 
Recall that we want to address two questions:   
 
1.  Are we growing? 
2.  What is happening with enrollment on our two campuses (Dahlonega and Gainesville)? 
3.  How has enrollment changed by major? 
 
For the first two questions, we will use some of the data on the Enrollment sheet.  Column A 
provides the year, Column B provides the number of students who were declared in a major that 
leads to a BBA degree (labeled “Headcount”), and Columns C, D, and E provide information on 
the number of semester hours of instruction provided on the Dahlonega campus (Dah), the 
Gainesville campus (GN), and overall (Total UG SCH).  [When a student takes a 3 semester hour 
course, they generate 3 Student Credit Hours (SCH)—10 students in a 3 semester hour course 
would generate 30 SCHs.]  For this data, students enrolled in on-line classes were managed out 
of the Dahlonega campus and included as Dah hours.  Although we might want to look at the 
number of students on each campus, the data have not been provided that way (and some 
students took classes on both campuses).  Also, since one of the primary uses for the data is for 
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scheduling classes, credit hours is probably a better predictor—since students taking 15 hours 
need more seats than students taking 6 hours).   
 
For the second question, we will use the data on the Majors sheet. 
 
Creating the Graph: 
 
For Question 1 (related to growth):  We will use cells E3 through E14 representing the total 
undergraduate Student Credit Hours (Total UG SCH) for this example.  Step 1:  Decide if you 
want to plot the average line on the chart.  We will work through the example both ways (with 
and without the average line).  You can plot a chart without the average line and add it later, but 
it is much easier to make the decision before your start!   
 
If you are going to plot the average line, you will need to create data that will tell Excel what to 
plot.  First we will put the average in E16 using the formula =average(E3:E14).  Remember you 
can drag over the E3 through E14 instead of typing the cell references.  Then we will create 
another column of data next to the Total UG SCH data where each entry in the column will be 
the average that we just found. To create the data, click on cell F2 and label the column (e.g., 
Avg. SCH).  Then click on cell F3 and tell Excel that you want the value in this cell to be the 
same as the one you calculated in cell E16 by typing =E16.  To put this value in each row of the 
column, we want to copy the formula down the column—but WAIT.  Since we want every entry 
in this column to be the value in cell E16 (“we absolutely want E16”), we need to make this an 
absolute reference.  To do this, we need to tell Excel that this is cell $E$16.  Actually, we could 
use E$16 since all of our entries will need to match the values in Row 16 of the column just to 
the left of this one.  Once we have the $ included, we can copy the value in F3 down the column 
resulting in the following: 
 

 
 
Step 2:  Select the data on the Enrollment sheet.   
If you do not want to plot the average line on the chart, select the Total UG SCH data (cells E3 
through E14) without the column heading.  
 
If you want to plot the average line on the chart, select the Total UG SCH and the Avg. SCH data 
(cells E3 through F14) without the column headings. 
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 Without the average plotted    With the average plotted 

     
 
Step 3: From the Insert Tab at the top of the page, select the Line Chart. 
If you do not want to plot the average line on the chart, use the “Line with Markers” option (first 
option on the second row under the Line Chart).   
 
If you want to plot the average line on the chart, you want to plot the dots for the observations, 
but you do not want to plot dots on the average line.  Excel’s initial graph will put dots on both 
sequences or on neither sequence (and will be have to change the one that is done incorrectly).  
We will tell Excel to leave the dots off initially (and we will add the dots for the observations).  
To do this, select the “Line” option (first option on the first row under the Line Chart).   
 
The following graphs show Excel’s initial chart  
 
 Without the average plotted    With the average plotted 

   
 
Step 4:  Clean up the graphs.  To do this  

 get rid of the gridlines (click on one and hit the delete key) 
 get rid of the legends (on both charts) 
 add the dots for the observations on the graph that includes the average line.  Do this by 

right clicking on the line connecting the observations and selecting “Format Data Series.”  
On the next dialogue box select “Marker Options” and then either Automatic or Built-in.  
If you select the Built-in option, select one of the solid options (small square, small circle, 
small triangle, or small diamond). 
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Step 5:  Add the chart title and axis labels.  This includes changing the scale on the horizontal 
axis to show the years by clicking on the current numbers, selecting the “Design” tab at the top 
of the spreadsheet, and using the “Select Data” option to edit the Horizontal (Category) axis 
labels.  Then select the data for the years (cells A3 through A14). 

 
 
Once this is done, add a Chart title and Axis titles from the Layout tab.  The resulting graphs are 
shown below. 
 
 Without the average plotted    With the average plotted 

           
  
For Question 2 (related to enrollment by campus): Constructing the graph for this option will be 
almost identical to the previous one without the average line.  The only major difference is that 
we will select the data and the column headings for the Dah and GN Credit Hours Data (C2 
through D14).  Selecting the column headings will provide the legend needed to distinguish the 
series that relates to each campus.  Using the identified data and the steps from the previous 
question, we obtain the following graph: 
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For Question 3 (related to distribution of students across majors):  For this question we will use 
the data on the Majors sheet (accessed at the lower left of the spreadsheet).  This chart will be a 
very easy follow-up to the previous one.  Select all of the data (cells A2 through H6), then from 
the Insert tab, select the Line option with the Line with Markers sub-option.  The resulting Excel 
graph needs a little cleaning up, but is almost finished.  NOTE:  The column headings and the 
row names must be formatted as text for this to work! 

 

To clean up the graph, remove the gridlines, add a Chart title, and add axis labels.  Ideally, the 
markers used for observations should be smooth and closed, but with five series we have limited 
options.  The final graph below uses the changes the marker on the Finance line to a closed 
circle.  Note:  Color can be useful or can be chartjunk.  If you will be printing the chart in black 
and white, color is chartjunk and may make see the chart more difficult.  Try to use different 
symbols for your dots as a signal for the legend and don’t depend on color. 
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Communicating the Results: 
 
 For Question 1:  Although there has not been growth each year over the previous year, the 
overall trend is one showing growth in the credit hours taught through Business.  This chart may 
provide insight into answers for some questions or may generate other questions.  FTwo 
examples during this period of time where the chart may provide insight would be:  1) what 
impact did adding a requirement for completion of Brief Calculus prior to most advanced 
business courses have on enrollment (starting in Fall 2010), and 2) what impact did the 
university system’s change from “tuition capped at 12 hours” to “tuition capped at 15 hours” 
have on enrollment (starting Fall 2009)?  Or the chart may lead us to asking, “What happened 
between 2006 and 2008?”  Prior to that period, enrollment was fairly consistent, then enrollment 
grew for a couple of years and appeared to “level” off again.  Be careful when generating such 
questions since you could be confusing coincidence  or correlation with cause-and-effect. 
 
Caution:  You may be tempted to change the vertical axis to remove the “white space” below the 
data.  Although this is reasonable in some cases (such as when we will be focusing on assessing 
stability later in the semester), the action may be deceptive in terms of communicating growth.  
Compare the graph above and the graphs below—the only difference is the change to the vertical 
axis.  By eliminating part of the vertical axis in the lower graph, the growth appears to be much 
greater, and by “stretching” the vertical axis in the lower graph, the growth appears to be 
minimal.   
 
   Removing the “white space” at the bottom   Stretching the vertical axis 

          
 
For Question 2:  From this chart we can see that there has been fairly steady increase in credit 
hour production on the Dahlonega campus, but credit hour production has decreased slightly 
over the last few years on the Gainesville campus.  As with the previous graph, this may beg the 
questions of “why” or “would this be expected to continue”?  The answer may be tied to a 
number of issues.  One theory relates to the economy.  During this period of time the Gainesville 
program was an evening, part-time program where many of the students were non-traditional 
students who worked full-time and took classes part-time.  When the economy had a downturn, 
businesses decreased educational benefits, laid off workers, and increased the workload for the 
remaining workers.  All of these could have led to fewer students in the program.   
 
Compare the Run Chart to the corresponding Bar Chart:  When you look at the Run Chart and 
the Unstacked Bar Chart using the same data, they are both attempting to answer the same 
question.  In order to evaluate credit hour production on each campus using the Bar Chart, you 
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try to focus on the height of each of the bars—and you attempt to compare the heights of the bars 
that are the same color (blue to blue and red to red).  Basically, the columns (the bars 
themselves) are chartjunk.  The Run Chart removes the chartjunk and makes comparisons easier. 
 

         
 
For Question 3:  This chart allows us to see how enrollment has changed for each of the majors 
within the BBA program.  [Note:  There is not a major called “Undecided.”  These are students 
who have indicated they are working on a BBA degree but have not decided which of the majors 
they plan to complete.]  From this graph we see that Accounting and Marketing have remained 
fairly constant, Finance as dropped slightly, and most of the growth in BBA students has come in 
the Management degree.  
 
Compare the Run Chart to the corresponding Bar Chart:  Similar to the comparison that we saw 
with the graphs for question 2, the Run Chart allows us to eliminate much of the chartjunk 
created by the columns on the Bar Chart.  In addition, the Run Chart makes it easier for us to 
compare the number of majors in any specific Spring (by looking at the heights of the dots for 
that Spring) and to look at trends in enrollment for each major (by looking at the pattern created 
by each sequenc). 
 

         
 
Checklist: 
 Make sure that you have the data arranged in appropriate columns 
 Determine if you are going to add a line for the average 
 Select the data to be used for the chart 

o Select the column headings and the data if you plan to have a legend 
o Select the data without the column headings if you are not going to have a legend 

 Select the Line Chart that will display the data in a way that best tells your story  
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o If you need dots on each series, select the option that plots dots in the initial graph 
o If you need dots on some but not all series, select the option that does not plot the dots 

(and then in the clean-up step, add the dots where they need to be) 
 Clean up any chartjunk that still exists (including the gridlines and any extra color) 
 Include a legend if one is needed (and do not include one if it is redundant) 
 Make sure that your scale on your axis is reflective of the characteristic plotted 
 Add axis titles 
 Add a title on the chart 
 Position your chart on the page so that it will print on a single page (without page breaks in 

the middle of the chart). 
 


